




UNIT-III

TOPIC-1

INTRODUCTION TO POWERPOINT

MS PowerPoint is a program that is included in theMicrosoft Office suite. It is used tomake presentations for
personal and professionalpurposes.

•Given below are a few important things that one must know about the development and introduction of
Microsoft PowerPoint:

•The program was created in a software company named Forethought, Inc. by Robert Gaskins and Dennis
Austin.

•It was released on April 20, 1987, and after 3 months of its creation, it was acquired by Microsoft.

•The first version of this program, when introduced by Microsoft was MS PowerPoint 2.0 (1990).

•It is a presentation-based program that uses graphics, videos, etc. to make a presentation more interactive and
interesting.

•The file extension of a saved Power point presentation is ppt".

•A PowerPoint presentation comprising slides and other features is also known as PPT.

•Gradually, with each version, the program was more creative and more interactive. Various other features were
added in PowerPoint which massively increased the requirement and use of this MS Office program.

•PowerPoint is a presentation application that creates a slide show of important information, charts, and
images to display during a presentation. Recent advances in PowerPoint include subtitling on slides, Presenter
Coach, and other enhanced interactive features.

•PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program which allows you to
create professional looking electronic slide shows. PPT is us to present information in an organized manner to
an individual or group.



•PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program which allows you to
create professional-looking electronic slide shows. PPT is used to present information in an organized manner
to an individual or group. Using clip art, sound clips, movie clips, graphs, organization charts, imported Web
screens, and many other features, you can easily create a presentation that will impress your audience and
convey your message clearly and professionally.



■ USING HELP:-

•PowerPoint Help menu offers you numerous ways to find help for a particular task. Type a
subject in the search window to see help topics.
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CREATING A PRESENTATION:

•(Slide 1)-Select a design template:-

1. In the PPT Start-up Window, click "From Design Template" located on the right-hand side of the screen
under the heading

2 "New." - Scroll down to see the various templates and click on one of them.

•(SLIDE 1. cont.)- Add title and subtitle

1. Click once on "Click to add title" (this is the title place holder) and type How to Use PowerPoint. Click
once on "click to add subtitle" and type Building an Effective Presentation.

•(SLIDE 2)-Add a Bulleted List slide:-

1. Click on the "New Slide" button at the toolbar located at the top of thescreen.

2. Click once on the title placeholder and type What you can do withPowerPoint.

•Click once on "Click to add text" (this is the text placeholder) and type the following text (hit
<Enter at the end of each line):

• Create electronic presentations Use special features to enhance your slides . Practice and time your slide
show

(NOTE: To format bullets, click on the "Format" menu and then click on "Bullets and Numbering.")

•(SLIDE 3)- Add a Text& Content Layout Slide:

1. Click on the "New Slide" button.



2. On the right side, scroll down until you see the "Text and Content Layout"options.

3. Click once on the option of your choice.

4. Type Content Options in the title placeholder.



5.In the text placeholder, add the following text (hit <Enter after each line).
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Clip Art Photographs

•Charts Graphs

•Tables Diagrams

•Media Clips

5. Click on the Clip Art icon in the "add content" area.

6. Enter medicine in the search window 8. Scroll through the results and double-click on the Clip Art of
your choice.

(Hint: Type "photograph in the Clip Art search window to see the clip art photo options)

•(SLIDE 4)- Add another Test& Contentslide:-

1.Click on the "New Slide" button.

2.Type Advantages to Using a Variety of Content in the title placeholder.

3. In the text placeholder, type the following text (hit <Enter at the end of eachline).

• Graphics keep a presentation lively

•Graphics are effective teaching tools Graphics keep the audience awake!

4. Add the Clip Art of your choice to the slide

•(SLIDE 5)- Add aChart:-

1. Click on the "New Slide" button.

2. Scroll down to "Other Layouts" and click on the "Title and Chart" option (the lastoption).

3. Type Simple Charts in the title placeholder.



4. Double-click on the chart placeholder.

5. A datasheet will appear. Make changes if you like. 6. Click once in your slide (outside the datasheet) to
add the chart to your slide.



[ Congratulations! You have completed a basic slide show. In the next lesson, we will enhance the
presentation to make it more interesting ]

CREATE A PRESENTATION:-

1.Open PowerPoint.

2. Select an option

3.Select Blank Presentation to create a presentation from scratch. 4

Select one of the templates.

5.Select Take a Tour, and then select Create, to see tips for using PowerPoint
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ADDA SLIDE

1. Select the slide you want your new slide to follow.

2. Select Home > New Slide

3. Select Layout and the you type want from the drop-down

ADDAND FORMAT TEXT:-

1. Place the cursor where you want, and type.

2. Select the text, and then select an option on the Home tab: Font, Font size, Bold, Italic, Underline,

3. Tocreate bulleted or numbered lists, select the text, and then select Bullets orNumbering



ADDA PICTURE, SHAPE, OR CHATS:-

1. Select Insert



2. Toadd a picture, Select Picture, Browse for the picture you want and select Insert.

3. Toadd a shape, art, or chart

•Select Shapes, Icons, SmartArt or Chart
•Select the one you want.

‐

BASICS OF MS POWERPOINT:-

•Discussed below are a few questions that one must be aware of while discussing the basics of MS
PowerPoint. Once this is understood, using the program and analysing how to use it more creatively shall
become easier.

▪ Answer: PowerPoint (PPT) is a powerful, easy-to-use presentation graphics software program that
allows you to create professional-looking electronic slide shows.

▪ Answer: Follow the steps below to open MS PowerPoint on a personal computer,

1. Click on the start button

2. Then choose "All Programs"

3. Next step is to select "MS Office"

4. Under MS Office, click on the "MS PowerPoint"

•A blank presentation is open on the screen. According to the requirement, a person can modify the
template for a presentation and start using the program.

▪ Answer: A combination of various slides depicting a graphical and visual interpretation of data, to
present information in a more creative and interactive manner is called a PowerPoint presentation or PPT.



▪ Answer: When all the slides of a PowerPoint presentation are set in series and then presented to a group
of people, where each slide appears one after the other, is a set pattern, this is known as a PowerPoint
slide show.

▪ Answer: The following elements can be added to a Power point slide:

1. ClipArt

2. Graphs

3. Tables

4. Photographs

5. Charts

6. Media Clips

7. Videos

▪All these elements are mainly used to enhance presentation skills and make the slide more interactive.

FEATURES OF MS POWERPOINT :-

▪There are multiple features that are available in MS PowerPoint which can customise and optimise a
presentation. The same have been discussed below.

■ SLIDE LAYOUT :-

▪ Multiple options and layouts are available based on which a presentation can be created. This option is
available under the "Home" section and one can select from the multiple layout options provided.

• Insert - Clipart, Video, Audio, etc.

▪Under the "Insert" category, multiple options are available where one can choose what feature they want
to insert in their presentation. This may include images, audio, video, header, footer, symbols, shapes, etc.



■ SLIDE DESIGN :-

▪ MS PowerPoint has various themes using which background colour and designs or textures can be
added to a slide. This makes the presentation more colourful and attracts the attention of the people
looking at it.

▪ This feature can be added using the "Design" category mentioned on the homepage of MS PowerPoint.
Although there are existing design templates available, in case someone wants to add some new texture or
colour, the option to customise the design is alsoavailable.

■ ANIMATIONS :-

▪ During the slide show, the slides appear on the screen one after the other. In case, one wants to add some
animations to the way in which a slide presents itself, they can refer to the "Animations" category.

▪ The different animation styles available on PowerPoint are; font size, font style, font colour, word art,
date and time, etc. can also be added to a PPT.

USES OF POWERPOINT PRESENTATION

● PowerPoint presentations are useful for both personal and professional usage Given below are a few of
the and professional usage.

■ USES OF PPT :-

● EDUCATION - With e-learning and smart classes being chosen as a common mode of education
today, PowerPoint presentations can help in making education more interactive and attract students
towards the modified version of studying.

● MARKETING - In the field of marketing, PowerPoint presentations can be extremely important.
Using graphs and charts, numbers can be shown more evidently and clearly which may be ignored by the
viewer if being read.

●BUSINESS - To invite investors or to show the increase or decrease in profits, MS PowerPoint can be
used

●CREATING RESUMES - Digital resumes can be formed using MS PowerPoint. Different patterns,
photograph, etc. can be added to the resume.



● DEPICTING GROWTH - Since both graphics and text can be added in a presentation, depicting the
growth of a company, business, student's marks, etc. is easier usingPPT
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AUTO CONTENT WIZARD :-

■ This wizard is useful for certain categories of presentations particularly business related presentations
provides templates and ideas for a wide variety of different types of presentation. PowerPoint will create a
number of slides for you and will suggest content relevant to that specific type of presentation.

■ This wizard helps you determine the content and organisation of your presentation by using an outline.

■ The AutoContent Wizard leads you through a series of questions so you can choose the best layout for
your presentation. The Wizard supplies not only the design but also ideas, starter text, formatting and
organisatio The colour scheme and the background colour will be selected for you although you can
change this afterwards.

■A very easy way to get started is to use the AutoContentwizard.

●The easiest way to create your first presentation is to use theAutoContent Wizard

●PowerPoint has an AutoContent Wizard to help you create a presentation. The wizard provides several
slides with different content guides. Presentation guides are available in several areas, including general,
corporate, and sales and marketing.

INSERT CLIP ART :-

1. Go to Insert Menu or Tab

2. Click on Online Pictures

3. Type keyword for search clipart in Online Pictures and press enter key.

4. Filter by types (Photograph, Clipart, Line drawing, Animated GIF, transparent), Layout (Square, Wide,
Tall), Color (Color Only, Black &White)

5. Select the image and click on Insert.



WORDART

●WordArt is a quick way to make text stand out with special effects. You begin by picking a WordArt
style from the WordArt gallery on the Insert tab, and then customize the text as you wish.

INSERTING AN AUTOSHAPE :-

● PowerPoint provides different that you can use to enhance your slides. For example, an AutoShape can
be a useful graphical element. Auto Shapes include lines, arrows, banners, stars, and other shapes you can
add to your presentation.

▪ Auto Shapes is a tool to help you draw objects on your document. You can choose to have an Auto
Shapes toolbar or use the Auto Shapes menu on the Draw toolbar or use the AutoShapes menu on the
Draw toolbar. Once you insert an Auto Shape, you can also put a Text Box inside it, or other shapes. You
can move or resize them as you wish.

● The slide is meant to compliment your presentation, not be the presentation.

● Images create immediate reactions. Words take much longer.

● Pictures help you focus, and helps people remember things.

■Why images are important for PowerPoint presentation?

The purpose of the words and images on each slide is to help the audience put your ideas in context. If
you present them with too many words, or with too many images, they'll be examining your slides instead
of listening to your verbal presentation.
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